Electronic Plan Review (EPR) Applicant Procedure

3/21/2022
Electronic Plan Review (EPR) Procedure for Applicants

Purpose

This procedure facilitates the City and County of San Francisco’s (CCSF’s) electronic plan review process using Bluebeam Studio Projects and Sessions. This document will introduce the Applicant to the steps required to submit, view, coordinate and respond to CCSF’s EPR comments in Bluebeam Studio Sessions from the start of the project through submittal to the CCSF.

Please note that if the Applicant chooses to use the optional EPR workflow for plan review, special software will be needed. Following this procedure requires: 1) Optical Character Recognition (OCR) function on scanned documents, and 2) Page Labeling function for the preparation of drawing documents, i.e. Bluebeam Revu or Bluebeam Revu eXtreme 20, 2019, 2018, or 2017. Screenshots and instructions typically use Bluebeam 2019.
Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section A – Registration Process</td>
<td>Using this Procedure</td>
<td>1</td>
</tr>
<tr>
<td>2.0</td>
<td>Account Setup for Bluebeam Studio</td>
<td>1</td>
</tr>
<tr>
<td>2.1</td>
<td>Create a New Studio Account</td>
<td>1</td>
</tr>
<tr>
<td>2.2</td>
<td>Set Required User Naming Conventions for Studio Account</td>
<td>1</td>
</tr>
<tr>
<td>Section B – Document Submission Process</td>
<td>Prepare Drawing Documents for Submittals</td>
<td>3</td>
</tr>
<tr>
<td>3.0</td>
<td>Prepare Drawing Documents for Submittals</td>
<td>3</td>
</tr>
<tr>
<td>3.1</td>
<td>Resources for Best Practice PDF Creation from Authoring Software</td>
<td>3</td>
</tr>
<tr>
<td>3.2</td>
<td>Document Naming Conventions for Document Submittals</td>
<td>3</td>
</tr>
<tr>
<td>3.3</td>
<td>Sheet Count and Drawing Index</td>
<td>3</td>
</tr>
<tr>
<td>3.4</td>
<td>Blank Areas on Cover Page and in Title Block for Stamps</td>
<td>4</td>
</tr>
<tr>
<td>3.5</td>
<td>Document Size and Volumes</td>
<td>5</td>
</tr>
<tr>
<td>3.6</td>
<td>Document Scale</td>
<td>5</td>
</tr>
<tr>
<td>3.7</td>
<td>Scanned Document Prep</td>
<td>5</td>
</tr>
<tr>
<td>3.8</td>
<td>Convert JPG Image files Back to PDF</td>
<td>6</td>
</tr>
<tr>
<td>3.9</td>
<td>Run Optical Character Recognition (OCR) on Scanned PDF files</td>
<td>8</td>
</tr>
<tr>
<td>3.10</td>
<td>Create Page Labels in Thumbnails</td>
<td>9</td>
</tr>
<tr>
<td>3.11</td>
<td>Create Bookmarks</td>
<td>12</td>
</tr>
<tr>
<td>3.12</td>
<td>Nesting Bookmarks</td>
<td>12</td>
</tr>
<tr>
<td>3.13</td>
<td>Set Scale on Floor Plans</td>
<td>14</td>
</tr>
<tr>
<td>3.14</td>
<td>Remove Layers</td>
<td>15</td>
</tr>
<tr>
<td>3.15</td>
<td>Create Drawing Call-Out Hyperlinks</td>
<td>16</td>
</tr>
<tr>
<td>3.16</td>
<td>Flatten Document</td>
<td>19</td>
</tr>
<tr>
<td>4.0</td>
<td>Prepare Additional Files for Submittals</td>
<td>20</td>
</tr>
<tr>
<td>4.1</td>
<td>Specifications Prep</td>
<td>20</td>
</tr>
<tr>
<td>4.2</td>
<td>Other Supporting Document Prep</td>
<td>20</td>
</tr>
<tr>
<td>5.0</td>
<td>Add CCSF Applicant Back Check Page</td>
<td>20</td>
</tr>
<tr>
<td>5.1</td>
<td>Locate &amp; Download the CCSF Applicant Back Check Page</td>
<td>21</td>
</tr>
<tr>
<td>5.2</td>
<td>Insert Applicant Back Check Page</td>
<td>21</td>
</tr>
<tr>
<td>6.0</td>
<td>Submit Documents to CCSF for Electronic Plan Review (EPR)</td>
<td>22</td>
</tr>
<tr>
<td>6.1</td>
<td>Submitting files via the CCSF City website (sf.gov)</td>
<td>22</td>
</tr>
<tr>
<td>6.2</td>
<td>Submitting files directly into a Bluebeam Studio Session (as applicable)</td>
<td>23</td>
</tr>
<tr>
<td>6.3</td>
<td>Submitting files directly into a Bluebeam Studio Project (as applicable)</td>
<td>24</td>
</tr>
<tr>
<td>7.0</td>
<td>Intake of Applicant Submittal Files</td>
<td>26</td>
</tr>
</tbody>
</table>

Section C – Plan Review Process
8.0 Initial Electronic Plan Review Process ........................................................................................................ 27
9.0 Incorporate CCSF Review Comments ........................................................................................................ 27
  9.1 Joining the Bluebeam Studio Session via Email Link ...................................................................................... 27
  9.2 Joining a Bluebeam Studio Session via Session ID ..................................................................................... 28
  9.3 Navigating Documents & Review Comments ............................................................................................. 28
  9.4 Filtering Comments .................................................................................................................................. 29
  9.5 Applicant Response to CCSF Reviewers’ Comments – Incorporating Comments ...................................... 29
  9.6 Add an additional “Reply” to comments .................................................................................................... 31
  9.7 Applicant Response to CCSF Reviewers’ Comments – Not Incorporating Comments ............................... 31
  9.8 Notify CCSF of Completed Comment Response ........................................................................................ 33
10.0 Subsequent Submittals .................................................................................................................................. 33
  10.1 Submit Subsequent Files via the CCSF City Website (sf.gov) ................................................................. 33
  10.2 Submit Subsequent Files Directly to a Studio Session or Project (if directed by CCSF) ..................... 33
  10.3 Intake of Applicant Subsequent Submittal files .......................................................................................... 34
  10.4 Subsequent Electronic Plan Review Process ............................................................................................ 34
11.0 Stamp-Out and Approval ............................................................................................................................ 35
Appendix 1: Document Naming Conventions for Applicant Submissions to CCSF DBI / Planning .............. 36
  1.0 CCSF Document Naming Components and Naming Structure .............................................................. 36
    1.1 File Name Examples ................................................................................................................................. 36
    1.2 File Name Component Summary ............................................................................................................. 36
    1.3 File Name Component Order .................................................................................................................. 37
    1.4 Document Type Naming Conventions and Prefix Numbers ................................................................. 37
    1.5 Permit-Type Naming Conventions ......................................................................................................... 37
    1.6 Addenda Naming Conventions ................................................................................................................. 37
    1.7 Revision Number Naming Conventions .................................................................................................. 38
  2.0 Document Naming Table for CCSF DBI / Planning Submissions ............................................................ 38
    2.1 Document Submissions for Planning or OCII – Initial Submissions ....................................................... 38
    2.2 Document Submissions for Planning or OCII – Subsequent Submissions ......................................... 38
    2.3 Document Submissions for Building – Initial Submissions .................................................................... 38
    2.4 Document Submissions for Building – Subsequent Submissions ......................................................... 39
    2.5 Document Submissions for Building – Addendum Document Submissions ......................................... 39
Appendix 2: Document Naming Conventions for Applicant Submissions to Port of SF ............................... 40
  1.0 Port of SF Document Naming Components and Naming Structure ....................................................... 40
    1.1 File Name Examples ................................................................................................................................. 40
    1.2 File Name Component Summary ............................................................................................................. 40
    1.3 File Name Component Order .................................................................................................................. 40
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.4 Permit Type Naming Conventions</td>
<td>40</td>
</tr>
<tr>
<td>1.5 Document Type Naming Conventions</td>
<td>40</td>
</tr>
<tr>
<td>1.6 Addenda Naming Conventions</td>
<td>41</td>
</tr>
<tr>
<td>1.7 Revision Number Naming Conventions</td>
<td>41</td>
</tr>
<tr>
<td>2.0 Document Naming Table for Port of SF Submissions</td>
<td>41</td>
</tr>
<tr>
<td>2.1 Documents for the Port of SF</td>
<td>41</td>
</tr>
<tr>
<td>2.2 Addendum Documents for Port of SF</td>
<td>42</td>
</tr>
<tr>
<td>Appendix 3: Bluebeam Versions and Use for Applicants</td>
<td>43</td>
</tr>
<tr>
<td>1.0 Identification of Paid (Licensed) or Free (Unlicensed) Versions</td>
<td>43</td>
</tr>
</tbody>
</table>
Section A – Registration Process

1.0 Using this Procedure

Note: This workflow is for customers comfortable using Bluebeam & Bluebeam Studio software. For customers that have no access to Bluebeam (Apple Macintosh users), an alternative workflow also exists for some procedure elements. Noteworthy workflow steps explained in this procedure include: creating a Bluebeam Studio Account, prepping PDF files for submittal/resubmittal using Bluebeam, submitting files, and Applicant response to CCSF review comments inside a Bluebeam Session.

Prior to each submittal to CCSF, the Applicant must first format all PDF plans and documents following the steps outlined in this procedure.

The Applicant will then submit formatted plans and documents electronically. The Electronic Plan Review (EPR) Support Staff generates a Bluebeam Studio Project specific to the Project’s Permit Application digital submission. The Bluebeam Studio Project serves as CCSF’s online storage location for all digital files related to the Permit Application. The EPR Support Staff will then perform a QAQC verification of the documents.

Once the Applicant’s submittal files have been accepted, the EPR Support Staff creates a Bluebeam Studio Session for the City and County of San Francisco (CCSF) review. The Bluebeam Studio Review Session is an online location for digital plan review.

Once the initial CCSF electronic review is complete, the Applicant will receive an email invitation to join the Bluebeam Studio Session to review and incorporate CCSF review comments.

2.0 Account Setup for Bluebeam Studio

Note: For the Applicant to use EPR in Bluebeam, the Applicant must use Bluebeam Studio and create a Bluebeam Studio account. Bluebeam Studio is a cloud-enabled system that is built into Bluebeam, that allows CCSF to store files and perform simultaneous plan review of PDFs with the Applicant. Using Studio requires the creation of a Studio Account. Although the Studio Account will not be needed until review reconciliation, it should be the very first item completed within this procedure.

Account setup does not require a paid version of Bluebeam.

2.1 Create a New Studio Account

2.1.1 Locate and click the “Studio” button

2.1.2 Within the Studio tab click the “Sign In” button to sign in or to create a new Bluebeam Studio account

Note: When creating an account for the first time, be sure to enter the Display Name in the following manner:
First Last – Company (ex: Mary Smith – XYZ Architects). If Applicant cannot list a company name, add the word “Applicant” instead (ex: Mary Smith – Applicant).

2.2 Set Required User Naming Conventions for Studio Account

Note: Applicant name information shall abide by the following protocol:
First Last – Company (ex: Mary Smith – XYZ Architects). If Applicant cannot list a company name, add the word “Applicant” instead (ex: Mary Smith – Applicant).
2.2.1 Once an Applicant has signed into Bluebeam, the user Display Name must be correctly entered in the following locations within the Preferences Dialog (found in the Revu pull-down menu, or press Ctrl + K)

2.2.1.1 Bluebeam Preferences dialog: The “User” field, located in the “General” tab

![Bluebeam Preferences dialog](image)

2.2.1.2 Bluebeam Preferences dialog: The “Display Name” field, located in the “Studio” tab in the “Server” section

![Bluebeam Preferences dialog](image)

2.2.2 In a web browser, enter “studio.bluebeam.com” and log in with the Bluebeam Studio login username and password.

2.2.2.1 Select the “My Profile” tab on the left
2.2.2.2 Verify the name located in the “Default Name” box
2.2.2.3 Correct the name and click the “Update Profile” button

2.2.3 Log out and then back into Bluebeam Studio once all changes have been made
Section B – Document Submission Process

3.0 Prepare Drawing Documents for Submittals

Note: All documents, including drawing documents, that require CCSF review and/or review comments must be PDF file type. Follow the steps outlined in this procedure to prepare applicable PDF files prior to submittal to CCSF.

Many of the steps for preparing a PDF documents require a paid version of Bluebeam.

3.1 Resources for Best Practice PDF Creation from Authoring Software

Note: Applicant is to ensure all best practices for PDF creation are used as applicable.

3.1.1 CCSF Exhibit F: General PDF Creation Guidelines.

3.1.2 PDF creation guidelines: found in the “Format your PDFs” section within the “How to create PDFs of your plans or addenda” page on the CCSF City (sf.gov) website: https://sf.gov/information/how-create-pdfs-your-plans-or-addenda

3.1.3 A note on Cross-Hatch fills:
Avoid the use of dense crossed-line fills within drawings, as use of dense (i.e. less than 1/8” apart on the plotted page) cross-line hatching can lead to rendering issues on PDFs. Dot patterns, earth patterns, and brick patterns are okay, as lines within those hatch patterns do not typically cross. Solid fill patterns are also generally okay if the solid pattern is not made from crossed lines. Use parallel lines instead.

3.1.4 A note on Digital Signatures:
Do not add certificate-type digital signatures on submittal documents. Files submitted to CCSF must be unlocked/unrestricted to editing, and applying a digital signature restricts changes to the file. Use only scanned graphic-type signatures if required.

3.2 Document Naming Conventions for Document Submittals

3.2.1 Ensure all documents are named per Appendix 1 (found at the end of this document) and/or Exhibit B: Document Naming Table for Applicant Submissions (found separately from this document). Naming instructions can also found in the “Name your PDFs” section of the “How to create PDFs” page on the CCSF City (sf.gov) website: https://sf.gov/information/how-create-pdfs-your-plans-or-addenda

3.3 Sheet Count and Drawing Index

Note: This aligns with CCSF procedures. Ensure set is coordinated prior to creating PDF of document.

3.3.1 In drafting software, list total sheet count on drawing sheet index page
3.3.2 Verify sheet count on the sheet index matches total PDF document sheet count.

3.4 Blank Areas on Cover Page and in Title Block for Stamps

Note: Each drawing page must have a space reserved for CCSF approval stamps as specified in the “How to create PDFs of your plans or addenda” section of the CCSF City (sf.gov) website. Areas stated here are just examples, to be superseded by direction of blank space areas on the CCSF City (sf.gov) website. See https://sf.gov/information/how-create-pdfs-your-plans-or-addenda for full instructions. Areas defined must be completely blank.

3.4.1 Provide a blank area within the title block. This reserved blank area must be in the same location for every page in the plan set.

3.4.2 Provide an additional blank area adjacent to the title block on the drawing set cover page (on the same page containing the Address, Description, and Index List)
3.5 Document Size and Volumes

3.5.1 If file size exceeds 350MB, the document shall be broken up into volumes by discipline or consistent number of sheets.

3.6 Document Scale

3.6.1 PDF Drawings shall be plotted/printed at Full 1:1 Scale from authoring software. Do not "Scale to Fit" or reduce the PDF page size to be smaller than the original printed page size.

3.7 Scanned Document Prep

Note: Scanned documents are slow to regenerate in Bluebeam – typically defined as taking more than 5 seconds per-page to regenerate. All scanned documents or pages that are slow to regenerate are required to go through this scanned document preparation section. It is not recommended that documents are scanned dots (raster) – ideally they should be “printed” lines (vector). See below.

3.7.1 Open the scanned PDF file
3.7.2 From the File Menu (located at the top of the Bluebeam screen), select “Export”
3.7.3 Click “JPEG”
3.7.4 Browser window will open
3.7.5 Browse to save to a local folder (ideally a new folder). Note the folder location
3.7.6 Select “Save”

3.8 Convert JPG Image files Back to PDF

3.8.1 From the File menu, select “Create”

3.8.2 Click “From Multiple Files”
3.8.3 Browser window will open

3.8.4 Locate folder containing JPEGs saved from previous section
3.8.5 Select image files
3.8.6 Select Open
3.8.7 Stapler dialog will open
3.8.8 Select “Advanced…” Button

3.8.9 Select 96 dpi from the resolution image drop down

3.8.10 Select OK
3.8.11 Add a file name to the “One Output File” field
3.8.12 Select “Use source file folder”

3.8.13 Click OK

3.9 Run Optical Character Recognition (OCR) on Scanned PDF files

Note: this OCR Section requires the Bluebeam eXtreme software version. It is optional for Applicants who do not have the eXtreme version of Bluebeam.

3.9.1 From the “Batch” pull-down menu, select “OCR”
3.9.2 Confirm All Pages are selected
3.9.3 Set Document Type to CAD Drawings
3.9.4 Check “Detect Vertical Text”
3.9.5 Check “Detect text in pictures and drawings”

3.9.6 Uncheck all other options
3.9.7 Click OK

3.10 Create Page Labels in Thumbnails

3.10.1 From any page, zoom into the area containing the sheet’s page number and label
3.10.2 Go to Thumbnails icon
3.10.3 Click the Create Page Labels icon to the right of the Thumbnails drop-down
3.10.4 Select Page Range > Select All Pages
3.10.5 Select Page Region > Click Select

3.10.6 Select Region of Page Label > Sheet Number

Note: Draw a window around the Sheet Number as big as possible while staying inside the titleblock lines. Avoid selecting additional text besides the Sheet Number. Notice the window being sketched within the area highlighted with the red box.

3.10.7 Enter a space, a hyphen, and a space after [Region 1]
3.10.8 Click add to select a second region for the bookmark

3.10.9 Select Region of Page Label > Sheet Name
Note: Draw a window around the Sheet Title as big as possible while staying inside the titleblock lines. Avoid selecting additional text besides the Sheet Name. Notice the window being sketched within the area highlighted with the red box.

3.10.10 Review AutoMark Preview and Click OK. Page Labels will generate

3.10.11 Review in the Thumbnails tab to verify the sheet number and sheet name have been captured properly

3.10.12 If incorrect, double left-click and change incorrect title(s), or redo Page Labels
3.11 Create Bookmarks

Note: Bookmarks can be created directly from Page Labels. Verify all Page Labels are complete and correct before creating Bookmarks.

3.11.1 Go to Bookmarks Tab
3.11.2 Click the “Create Bookmarks” icon
3.11.3 Select Page Labels and verify Page Range > Click OK

![Create Bookmarks Dialog Box]

3.11.4 Page Label content will appear in the Bookmarks tab
3.11.5 Click the Bookmarks icon and select “Audit Bookmarks” from drop-down menu to confirm no broken bookmarks are found

![Bookmarks Dialog Box with Audit Bookmark Selected]

3.12 Nesting Bookmarks

Note: Before Nesting Bookmarks, verify all Bookmarks contain correct page label names matching the names in the Thumbnails (which match drawing sheet numbers & labels)

3.12.1 Go to ‘Bookmarks’ Tab
3.12.2 Select the first sheet in each section
3.12.3 Right-click > Click “Add” > Select “Add Before…”

3.12.4 Name new bookmark by section - Example: ELECTRICAL

3.12.5 Select all “E” sheets and nest by pulling the documents over to the right under the ELECTRICAL bookmark

3.12.6 Repeat for all disciplines and other applicable documents (i.e., specifications which contain bookmarked sections)
3.13 Set Scale on Floor Plans

Note: In addition to PDF plotting at Full 1:1 Scale, all Floor Plan Sheets should contain an appropriate measurement Scale that is stored in the PDF page.

3.13.1 Locate the Floor Plans
3.13.2 Verify a scale is listed in the title of the Floor Plan. Applicants must include a scale identification on all Floor Plans

1 MAIN LEVEL FLOOR PLAN

3.13.3 Within the "Measurements" panel locate the Page Scale section

3.13.4 Set Precision to 1/2
3.13.5 Manually enter the Scale to match the Scale of the Floor Plan, or select the scale from the “Preset” Scales (Bluebeam 2019)

Bluebeam 2019  Bluebeam 2018
3.13.6 Once the scale has been applied on a page, that scale is stored in the page. In Bluebeam 2018, the “Store Scale in Page” option is checked. In Bluebeam 2019, the page scale is listed within the Thumbnail. Check “Page Scale” in the Bluebeam 2019 Label Options.

3.13.7 Repeat for all Floor Plans

Note: Once a Scale is set on one page, it will become the default to set other pages in Bluebeam 2018 - by checking “Store Scale in Page”. In Bluebeam 2019, use the “Apply to Page Range” button to set multiple pages.

3.14 Remove Layers

3.14.1 Go to Layers Tab
3.14.2 Select layers listed

Note: To select all quickly, select the top layer of the list, hold the shift key and select the bottom layer simultaneously.
3.14.3 Right-click on highlighted layers and select Delete from the drop-down menu

3.14.4 Uncheck all options

3.14.5 Click Delete

3.15 Create Drawing Call-Out Hyperlinks

Note: this Hyperlinks Section requires the Bluebeam eXtreme software version. It is optional for Applicants who do not have the eXtreme version of Bluebeam.
3.15.1 Select “Add Open Files” uncheck any files that are not drawing files

3.15.2 Click Next

3.15.3 Select Settings

3.15.4 Select Filter Mode: “First from start”

3.15.5 From the Batch pull-down menu, select Link > New
3.15.6 Select Filter Character. “Space”
3.15.7 Click OK

![Image of filter character selection window]

3.15.8 Click Link Options
3.15.9 Check Include Appearance Properties
3.15.10 Select a light-yellow color
3.15.11 Set Style to Highlight
3.15.12 Click OK

![Image of link options window]
3.15.13 Select Page Label
3.15.14 Click "Generate"
3.15.15 Search Terms will generate
3.15.16 Click run to create hyperlinks

3.15.17 Once the hyperlinks are created, click "Finish and Close"

3.16 Flatten Document

3.16.1 From the "Document" pull-down menu, select "Flatten"
3.16.2 In the “Flatten Markups” dialog, check “All Markups”
3.16.3 Verify ‘Allow Markup Recovery (Unflatten)’ is unchecked

3.16.4 Click Flatten
3.16.5 Save Documents

4.0 Prepare Additional Files for Submittals

Note: Additional document such as Specifications, Calculations, and other supporting files must be prepared in addition to the drawings to allow for proper review by CCSF. Files requiring review and/or comments by CCSF must be PDF file type. Reference files may be other typical file types (Word, Excel, etc.)

Preparation for non-drawings PDFs typically does not require a paid version of Bluebeam.

4.1 Specifications Prep
   4.1.1 Specifications shall contain bookmarks identifying Specification Divisions
   4.1.2 Specifications shall be free of Layers
   4.1.3 Specifications shall be Flattened

4.2 Other Supporting Document Prep
   4.2.1 All additional supporting documents shall be free of Layers
   4.2.2 All additional supporting documents shall be Flattened

5.0 Add CCSF Applicant Back Check Page

Note: Inserting the CCSF Applicant Back Check Page automatically adds the CCSF Custom Status Menu. The Status Menu applied to the document allows the Applicant to track the review & incorporation comments, and CCSF Reviewers to track OPEN and CLOSED comments.
IF THE CCSF APPLICANT BACK CHECK PAGE IS NOT PROPERLY ADDED, THE REVIEWER BACK CHECK CANNOT BE PERFORMED PROPERLY

5.1 Locate & Download the CCSF Applicant Back Check Page

Note: The Back Check Page can be downloaded from the following location: https://sf.gov/add-our-back-check-page-your-plans

5.2 Insert Applicant Back Check Page

Note: This step requires a licensed version of Bluebeam

5.2.1 In Bluebeam, open the submittal files (all documents where CCSF Reviewers may potentially add review comments)

5.2.2 Once all files are open, insert the Applicant Back Check Page as the last page in each document

5.2.2.1 From the “Document” pull-down menu, select “Insert > Pages from Document”

Note: If the “Open Project File” dialog appears, click “Open from Disk”. If “Insert Pages” dialog opens, click the “Add” button
5.2.2.2 Browse to the locate the CCSF Bluebeam Back Check Menu Page and open the file

5.2.2.3 In the “Insert Pages” dialog, select “After” and check “Last Page” to insert the cover page at the end of the document

5.2.2.4 Click OK

5.2.3 Verify the Page has been added at the end of the document

5.2.4 Repeat for all submitted files that require Session review or addition of the back check menu

6.0 Submit Documents to CCSF for Electronic Plan Review (EPR)

Note: Section 6.0 defines the submission process to CCSF (DBI, Planning, etc.). For submissions to the Port of San Francisco, the applicant process uses Microsoft SharePoint. Applicants working on projects sited on Port Property will interface with SharePoint for both document submission and document retrieval throughout the permit process. Refer to the Port of SF website for instructions on how to submit documents to the Port Permit Desk for Electronic Plan Review: https://sfport.com/business/permit-services/electronicplanreview

6.1 Submitting files via the CCSF City website (sf.gov)

Note: Once the Applicant has prepared and correctly formatted the PDF files, the Applicant will upload the files to the “Building Permits” section of the sf.gov website using the instructions found within the “Apply for a Building Permit” and “How to create PDFs of your plans or addenda” sf.gov webpages.

6.1.1 Ensure all documents are correctly formatted as defined within this procedure. Improperly formatted documents will be rejected by CCSF

6.1.2 Ensure the CCSF Applicant Back Check Page has been added as the last page of each submission document
6.1.3 Open a web browser, and enter the following web address:
https://sf.gov/topics/building-permits

6.1.4 Choose the appropriate permit type and/or scroll to locate the “Resources” areas for Electronic Plan Review (EPR).

   Note: Some permits, such as Over the Counter (OTC) permits, are not available to submit online

6.1.5 Follow the instructions to verify Forms and Project Qualifications. The section contains additional instructions for document creation, and an “Apply Now” button to submit prepared documents

6.2 Submitting files directly into a Bluebeam Studio Session (as applicable)

   Note: In most cases, the Applicant will submit files via the CCSF City (sf.gov) website, not directly into Bluebeam Studio.

   In rare cases CCSF may determine that the Applicant will upload directly to the Bluebeam Session. The Applicant will receive, as part of their invitation & link to the Studio Session, instructions to “resubmit the entire set of drawing plans by uploading the revised set to the Session”. The Applicant should only attempt to submit directly to the Session if they receive these specific instructions.

   Uploading files directly to a Bluebeam Studio Session requires a paid version of Bluebeam.

   Access to a Bluebeam Studio Session requires a Bluebeam Studio Account. Refer to the “Account Setup for Bluebeam Studio” section located within this Procedure for instructions on setting up a Studio account and required display name conventions for Studio accounts. The Account and display name must be set prior to submitting.

   In addition to a link, the Bluebeam Studio Session can also be joined using a (Bluebeam Studio Project) Studio ID, which will be included in the invite email. The Studio ID is a random nine-digit code provided by CCSF. It is unrelated to the Application number or project address, etc.

6.2.1 Ensure all documents are named and formatted as defined within this procedure. Improperly formatted documents will be rejected by CCSF

6.2.2 Ensure the CCSF Applicant Back Check Page has been added as the last page of each submission document

6.2.3 Open Bluebeam Software

6.2.4 Verify connection to Bluebeam Studio (i.e. the icon is “plugged in”)

6.2.5 Open the Bluebeam Studio Session

   6.2.5.1 Refer to the sections titled “Joining the Bluebeam Studio Session via Email Link” and/or “Joining a Bluebeam Studio Session via Session ID” located in the “Incorporate CCSF Review Comments” Section of this document (Section 9.0)
6.2.6 Once the Session is opened, locate the “Documents” area in the Session tab.

6.2.7 Click the “Add File” button within the “Documents” area.

Note: If the “Add File” button is missing, it indicates the “Add Documents” Session permission has not been granted to the email address used by the Applicant to sign into Bluebeam Studio. Verify with the CCSF EPR Support Staff that the email address used by the Applicant to access the Studio Session has the “Add Documents” Session permission.

6.2.7.1 Browser window will open
6.2.7.2 Select the PDF file (Hold Ctrl or Shift to select Multiple files)
6.2.7.3 Select Open to add the files

6.2.8 Notify CCSF DBI Reviewer and EPR Support Staff

6.2.8.1 Once all submittal files have been successfully added to the Studio Session, notify the DBI Plan Reviewer, as well as any applicable CCSF EPR Support Staff of Bluebeam Session submittal via email. **Do not use Bluebeam Alerts to notify Reviewers or other CCSF Staff.**

6.3 Submitting files directly into a Bluebeam Studio Project (as applicable)

Note: In most cases, the Applicant will submit files via the CCSF City (sf.gov) website, not directly into Bluebeam Studio.

In rare cases CCSF may determine that the Applicant will upload directly to the Bluebeam Project. The Applicant will receive an invitation to submit to the Studio Project and a link to the Studio Project via email. This invitation will be separate from the invitation to join the Studio Session.

Uploading files directly to a Bluebeam Studio Project requires a paid version of Bluebeam.

Access to a Bluebeam Studio Project requires a Bluebeam Studio Account. Refer to the “Account Setup for Bluebeam Studio” section located within this Procedure for instructions on setting up a Studio account and required display name conventions for Studio accounts. The Account and display name must be set prior to submitting.

A Bluebeam Studio Project can also be joined using a (Bluebeam Studio Project) Studio ID, which will be included in the invite email. The Bluebeam Studio Project ID is a random nine-digit code provided by CCSF. It is unrelated to the Application number or project address, etc.
6.3.1 Ensure all documents are named and formatted as defined within this procedure. Improperly formatted documents will be rejected by CCSF.

6.3.2 Ensure the CCSF Applicant Back Check Page has been added as the last page of each submission document.

6.3.3 Open Bluebeam Software

6.3.4 Verify connection to Bluebeam Studio (i.e. the icon is “plugged in”)

6.3.5 Open the Bluebeam Studio Project by clicking the link included in the email invitation (provided by CCSF). As long as the Applicant is connected to Bluebeam Studio, the link will open the Studio Project tab automatically.

6.3.6 If a link is not available or not working, the Applicant may also open the Studio Project manually if they have been invited and have the Studio Project ID.

   Note: The Bluebeam Studio Project ID is a random nine-digit code provided by CCSF. It is unrelated to the Application number or project address, etc.

   6.3.6.1 Click the Studio Projects button
   6.3.6.2 Under Studio drop-down menu select +. The “Join” dialog box appears.

   ![Join dialog box]

   6.3.6.3 Enter the nine-digit Bluebeam Studio Project ID
   6.3.6.4 Click OK. The Bluebeam Project tab will open.

6.3.7 Once the Studio Project tab is open, locate the CCSF EPR folders. In the PERMIT SUBMITTAL folder, locate the sub folder titled 3. DOCUMENTS FOR REVIEW

   ![CCSF EPR folders]

   A. PERMIT SUBMITTAL
   1. PERMIT FORMS
   2. ROUTING FORMS
   3. DOCUMENTS FOR REVIEW

   B. APPROVED DOCUMENTS
   1. BUILDING PERMIT DOCUMENTS
6.3.7.1 Right click on folder
6.3.7.2 Select Upload Files Icon

![Image of folder with upload files option]

6.3.7.3 Browser window will open
6.3.7.4 Select the file to upload (Hold Ctrl or Shift to select Multiple files)
6.3.7.5 Select Open to upload the files

6.3.8 Notify CCSF of Submittal

6.3.8.1 Once all submittal files have been successfully uploaded to Studio Project, notify CCSF EPR Support Staff of Bluebeam Project submittal via email. Do not use Bluebeam Alerts to notify Reviewers or other CCSF Staff.

7.0 Intake of Applicant Submittal Files

Note: Once CCSF EPR Support Staff receives the Applicant submission, the EPR Support Staff will perform a QAQC review of the submitted files. If document preparation is incomplete and/or not in compliance with this procedure, EPR Support Staff will notify the Applicant and request an updated resubmittal to CCSF.
Section C – Plan Review Process

8.0 Initial Electronic Plan Review Process

Note: Once the initial review documents have been uploaded by the Applicant and have received approval from CCSF EPR Support Staff, a notification will be sent out to CCSF Reviewers to begin the plan review process. Review time starts when the documents are found to be satisfactory. Departments reviewing include Planning, DBI (Department of Building Inspection), PUC (Public Utilities Commission), PW (Public Works), DPH (Department of Public Health) and MOD (Mayor’s Office of Disability). Reviews may be performed sequentially or simultaneously.

Once the initial review phase is completed, the applicant will be invited into a Bluebeam Session to incorporate comments. Applicants will respond, using the custom Status Menu, prior to resubmitting revised documents. Once changes have been addressed by the Applicant, the Applicant will create and upload subsequent submittal documents. Do not upload subsequent submittals until all CCSF Reviewer stations/departments have completed their reviews.

Applicants that have no access to a free version of Bluebeam Revu (Apple Macintosh users) can work directly with the CCSF DBI Reviewer and/or CCSF Support staff to receive PDF drawings via the SF SecureShare file sharing service. Reference EPR Exhibits K1 and K2 when contacting CCSF for additional information regarding using this service.

9.0 Incorporate CCSF Review Comments

Note: Once the CCSF initial document review has been completed, Applicant will be invited via email into a Bluebeam Review Session to incorporate comments. Incorporating comments is a joint process between the CCSF review team and the Applicant.

Incorporation response to Reviewer comments does not require a paid version of Bluebeam

Access to a Bluebeam Studio Session requires a Bluebeam Studio Account. Before joining the Session, refer to the “Account Setup for Bluebeam Studio” section located within this Procedure for instructions on setting up a Studio account and required name conventions for Studio accounts.

9.1 Joining the Bluebeam Studio Session via Email Link

9.1.1 Open Bluebeam Software
9.1.2 Ensure Bluebeam Studio is Connected (icon is “plugged in”)
9.1.3 Locate the Bluebeam Studio Session invitation email
9.1.4 Click the link within the invitation to connect to the Bluebeam Studio Session
9.2 Joining a Bluebeam Studio Session via Session ID

9.2.1 Locate the Bluebeam Studio Session invitation email containing the nine-digit Bluebeam Session ID (ex. 111-222-333)
9.2.2 Open Bluebeam Software
9.2.3 Connect to Bluebeam Studio and click the Session button
9.2.4 Ensure Bluebeam Studio is Connected (icon is “plugged in”)
9.2.5 Within the Studio tab, locate and click the ‘plus’ button + . The “Join” dialog box appears

9.2.6 Enter the nine-digit Bluebeam Session ID and click “OK”

9.3 Navigating Documents & Review Comments

Note: For Bluebeam Studio Session layout, refer to Exhibit E: Bluebeam Studio Session Layout

9.3.1 Right-click on Session document. Select Open

9.3.2 Open the Markups List Panel

Note: the Markups List panel is typically located on the bottom of the Bluebeam software. In the “Window” pull-down menu, select “Panels > Markups” or press ALT+L to show the Markups list if it is hidden.
9.3.3 Locate Reviewers’ markup comments in the Markups List

Note: The Markups List automatically tracks information for each Reviewer markup placed on a PDF, including Date, Page Label, Author, Color, Comments and Status. By default, it is found in the bottom panel.

![Markups List Image]

9.4 Filtering Comments

Note: The Filter feature within the Markups List allows a user to temporarily remove markup comments – “filtering”, or removing those comments based upon specific parameters. One can filter to only show a specific Author of comments, a specific page of comments, etc.

9.4.1 On the Markups list toolbar, click the Filter icon

![Filter Icon Image]

9.4.2 A filter icon then appears next to each column heading in the Markups list

![Filter Applied Image]

9.4.3 Click the filter icon associated with the desired column and select the value to filter

9.4.4 Repeat as desired to filter by other values.

Note: While filters are active, the markups list shows only those markups that match the selected filters. All other markups are hidden.

9.5 Applicant Response to CCSF Reviewers’ Comments – Incorporating Comments

Note: Applicants must respond to each and every comment to indicate a reconciliation action or inaction to the reviewer.
To notify the reviewer that the markup comment will be integrated into a revised document submission, the Applicant will set the Status of the comment to “Incorporated”. There are two ways to do this: Right-clicking on the comment, or double-clicking in the status column of the comment.

Once the Applicant has updated/revised the drawings and other documents per the review comments (prior to the subsequent submittal), the Applicant will use the Markups List “Status” column to indicate to CCSF that the Reviewers’ comment has been incorporated

9.5.1 Incorporate Comments by Right-Clicking

9.5.1.1 Locate the Reviewer’s comment (either on the page or in the Markups List)

9.5.1.2 Right-click on the comment and select the Set Status

9.5.1.3 From CCSF Back Check Status menu titled “*****Applicant’s response prior to revised submittal*****” select “INCORPORATED (per reply as needed)”
9.5.1.4 Repeat until all comments have been incorporated completely

9.5.2 Incorporate Comments using the Status Column

9.5.2.1 Double-click on the comment inside of the status column and select “INCORPORATED (per reply as needed)” from “*****Applicant’s response prior to revised submittal*****”.

9.6 Add an additional “Reply” to comments

9.6.1 To add a comment/note related to a markup response, Right-click on the comment (either on the page or in the Markups List) and select “Reply” from drop-down menu. Type a response in the open text box stating how the comment has been addressed. Clearly indicate the location and changes to be provided.

9.7 Applicant Response to CCSF Reviewers’ Comments – Not Incorporating Comments

Note: Applicants must respond (using the “Reply” function) to each comment to indicate a reconciliation action or inaction to the reviewer.

To notify the reviewer that the markup comment will NOT be integrated into a revised document submission, the Applicant will set the Status of the comment to “Not Incorporated”. There are two ways to do this: Right-clicking on the comment or double-clicking in the status column of the
comment. The Applicant must also add a response using the “Reply” function for each unincorporated comment, to explain the reason for non-compliance / not integrating the reviewer’s comment into the revised submission.

9.7.1 Locate the Reviewer’s comment
9.7.2 Double-click on the comment inside of the status column, and select “NOT INCORPORATED (per reply)” from CCSF Back Check Status menu titled “*****Applicant’s response prior to revised submittal*****”
9.7.3 Right-click on the comment and select Set Status > “NOT INCORPORATED (per reply)” from CCSF Back Check Status menu titled “*****Applicant’s response prior to revised submittal*****”

9.7.4 Add the required “Reply” comment to the response by right-clicking on the comment and selecting “Reply” from the drop-down menu.
9.7.5 Type a response in the text box stating the reason that the comment was not addressed. Clearly indicate the reasoning and explanation for non-compliance.
9.8 Notify CCSF of Completed Comment Response

9.8.1 Once Applicant comment response is completed within the Studio Session, notify the DBI Plan Reviewer, as well as any applicable CCSF EPR Support Staff, via email. Do not use Bluebeam Alerts to notify Reviewers or other CCSF Staff.

10.0 Subsequent Submittals

Note: Subsequent plan check submittals shall be submitted as entire sets of drawing plans – responding to corrections requested in the prior review. The Applicant shall resubmit the entire drawing set, even if markup comments/changes only appear on a few of the individual pages.

Once changes have been addressed by the Applicant, the Applicant will create and upload subsequent submittals to the CCSF City Website or to Bluebeam Studio as directed by CCSF. After EPR Support Staff have completed the intake review and found it to be satisfactory, EPR Support Staff will send out a notification to the reviewers to begin the Subsequent Submittal review.

10.1 Submit Subsequent Files via the CCSF City Website (sf.gov)

10.1.1 Ensure all documents are named per Appendix 1 (found at the end of this document) and/or Exhibit B: Document Naming Table for Applicant Submissions (found separately from this document). Naming instructions can also be found in the “Name your PDFs” section of the “How to create PDFs” page on the CCSF City (sf.gov) website: https://sf.gov/information/how-create-pdfs-your-plans-or-addenda

10.1.2 Ensure all documents are correctly formatted as defined within this procedure. Improperly formatted documents will be rejected by CCSF.

10.1.3 Open a web browser, and enter the following web address: https://sf.gov/topics/building-permits

10.1.4 Choose the appropriate permit, and/or scroll to the Electronic Plan Review Resources section. Follow the instructions to verify Forms and Project Qualifications. The section contains additional instructions for revised documents, and a “Submit” button to submit the prepared documents.

10.2 Submit Subsequent Files Directly to a Studio Session or Project (if directed by CCSF)

Note: Refer to Section titled “Submit Documents to CCSF for EPR” for additional instructions

10.2.1 Ensure all documents are named per Appendix 1 (found at the end of this document) and/or Exhibit B: Document Naming Table for Applicant Submissions (found separately from this document). Naming instructions can also be found in the “Name your PDFs” section of the “How to create PDFs” page on the CCSF City (sf.gov) website: https://sf.gov/information/how-create-pdfs-your-plans-or-addenda

10.2.2 Ensure all documents are correctly formatted as defined within this procedure. Improperly formatted documents will be rejected by CCSF.

10.2.3 Ensure that the CCSF Applicant Back Check Page has been added at the end of all submittal documents

10.2.4 Open Bluebeam Software and ensure Bluebeam Studio is connected.

10.2.5 If submitting directly into a Studio Session

10.2.5.1 Join the Bluebeam Session. Refer to previous sections titled “Joining the Bluebeam Studio Session via Email Link” and/or “Joining a Bluebeam Studio Session via Session ID” for instructions
10.2.5.2 Add the PDFs using the “Add File” button. Refer to the previous “Submitting files directly into a Bluebeam Studio Session” Section of these Procedures for instructions.

10.2.6 If Submitting directly into a Studio Project

10.2.6.1 Join the Bluebeam Project

10.2.6.2 Upload the documents into the DOCUMENTS FOR REVIEW folder

Note: Refer to the previous “Submitting files directly into a Bluebeam Studio Project” Section of these Procedures for instructions on both joining the Studio Project and Uploading documents.

10.2.7 Once the files are submitted, notify CCSF EPR Support Staff of Subsequent Submittal via email. Do not use Bluebeam Alerts to notify Reviewers or other CCSF Staff.

10.3 Intake of Applicant Subsequent Submittal files

Note: Once Applicant files have been submitted to CCSF, the CCSF EPR Support Staff will perform a QAQC review of the submitted files. If document preparation is incomplete, EPR Support Staff will notify the Applicant and request an updated resubmittal to CCSF.

When EPR Support Staff have completed the intake and QAQC review and found the submitted files to be satisfactory, they will send out a notification to the CCSF reviewers to resume the Subsequent Electronic Plan Review.

10.4 Subsequent Electronic Plan Review Process

Note: Once the Subsequent review documents have been uploaded and passed intake from the CCSF EPR Support Staff, CCSF Reviewers will resume the plan review process.

After the Subsequent review phase has been completed, the applicant will be notified to rejoin the Electronic Plan Review session to incorporate subsequent comments. The subsequent electronic plan review session will almost always be the same session as the initial review session. Refer to the “Joining the Bluebeam Studio Session” Section of these Procedures.

Applicants will respond to reviewer’s comments using the custom Status menus in the Bluebeam Markups List prior to resubmitting revised documents.

10.4.1 Create a Markup Alert to track Reviewer progress

Note: It is the Applicants’ responsibility to remain “active” during the subsequent review process, as the Reviewers will not notify Applicants when subsequent comments are made. Applicants may want to create Mark-up Alerts in Bluebeam to better track the progress of Reviewers.
10.4.1.1 From the Session list (before entering the Session), right-click the Session name and select “Manage Notifications”

![Image of Studio Notifications Preferences in Bluebeam]

10.4.1.2 A WebTab titled Studio Notifications Preferences will open in Bluebeam

10.4.1.3 In the Account Preferences section, check the box to “Send me an email with Markup Alerts for all Sessions”

![Image of Account Preferences settings]

10.4.1.4 Click “Apply” and close the WebTab

Once changes have been addressed by the Applicant, the Applicant will create and upload additional subsequent submittals as required, until all submittal documents comply with CCSF requirements.

11.0 Stamp-Out and Approval

Note: Each departments’ EPR Reviewer will apply an approval stamp to the document(s) once their respective review is completed. Once all departments have reviewed and approved the documents, the EPR Support Staff will be notified that the electronic plan review is complete, and the project is approved. EPR Support Staff will then notify Permit Services that the documents are ready for final issuance of permit. Once that process is completed, the Applicant will be notified of “Final Approval” of the project by CCSF Permit Services. The Applicant will also receive a link to download the approved files.
Appendix 1: Document Naming Conventions for Applicant Submissions to CCSF DBI / Planning

Note: All documents submitted to CCSF DBI / Planning must follow naming guidelines. The descriptions and tables below identify the most common submissions.

1.0 CCSF Document Naming Components and Naming Structure

1.1 File Name Examples

- 001-FORM 3-8 202201014784.pdf
- 101-SITE DWGS-REV0 202201014784.pdf
- 202-BLDG SPEC-REV1-202201014784.pdf
- 303-BLDG CALCS-REV2 202201014784_ADD2 MEP.pdf
- 401-SITE REPORT Lighting-REV0 202201014784.pdf
- 501-LETTER PW to DBI-REV0 202201014784.pdf

(Number Prefix)-[Document type]-[Revision Number] [Application Number]_[Type / Count of Addenda]

Example of CCSF Session Documents:

```
[File names and directory structure]
```

1.2 File Name Component Summary

1.2.1 CCSF Submission File Names will always contain four to five parts:

- **Number Prefix.** The Number prefix serves two functions: to identify the type of document (101 for Drawings, 201 for Specifications, etc.), and to provide an order for
the type of document (201 = First Specification Doc; 202 = Second or Revised Specification Doc).

- **Document type.** Typically one of the six standard document types: Forms, Drawings, Specifications, Calculations, Reports and Letters
- **A Revision number.** The Initial Submission is considered “REV0”. Subsequent Revised Submissions contain REV1, REV2, REV3, etc.
- **Application number.** If no Application number exists, substitute the street address of the project.
- **Type of Addenda & Count of Addenda.** If applicable.

### 1.3 File Name Component Order

1.3.1 File name components will be in the following order:

- [Number Prefix]-[Document type]-[Revision Number] [Application Number]_[Type / Count of Addenda]

If no Application number exists yet, substitute the street address of the project:

- [Number Prefix]-[Document type]-[Revision Number] [Street address]_[Type / Count of Addenda]

### 1.4 Document Type Naming Conventions and Prefix Numbers

1.4.1 CCSF accepts six document types. Each type has a prefix identifier:

- Forms (FORMS) – 001, 002, 003, etc
- Drawings (DWGS) – 101, 102, 103, etc.
- Specifications (SPECS) – 201, 202, 203, etc.
- Calculations (CALCS) – 301, 302, 303, etc.
- Reports (REPORTS) – 401, 402, 403, etc.
- Letters (LETTERS) – 501, 502, 503, etc.

### 1.5 Permit-Type Naming Conventions

Note: For each document type, the Applicant must specify if they are for Site permits or Building permits in the file name.

1.5.1 **Site Permit Name Examples:**

- Drawings: SITE DWGS
- Calculations: SITE CALCS
- Reports: SITE REPORTS

1.5.2 **Building Permit Name Examples:**

- Drawings: BLDG DWGS
- Calculations: BLDG CALCS
- Reports: BLDG REPORTS

### 1.6 Addenda Naming Conventions

1.6.1 Addenda must contain “BLDG ADD_[X]” as well as the addenda type included. CCSF accepts the following types of addenda:

- Grading
• Foundation
• Superstructure
• Architecture
• Mechanical, electrical and plumbing (MEP)
• Final

1.7 Revision Number Naming Conventions

1.7.1 Include a revision number as "-REV[X]" with the X being the revision number (REV1, REV2, etc.). Submittal first drafts include a "REVO" number.

2.0 Document Naming Table for CCSF DBI / Planning Submissions

2.1 Document Submissions for Planning or OCII – Initial Submissions

<table>
<thead>
<tr>
<th>First Component</th>
<th>Second Component</th>
<th>Third Component</th>
<th>Fourth Component</th>
<th>Fifth Component (as Applicable)</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>-SITE FORMS</td>
<td>-REVO (as applicable)</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>101</td>
<td>-SITE DWGS</td>
<td>-REVO</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>201</td>
<td>-SITE SPECS</td>
<td>-REVO</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>301</td>
<td>-SITE CALCS</td>
<td>-REVO</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>401</td>
<td>-SITE REPORTS</td>
<td>-REVO</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>501</td>
<td>-SITE LETTERS</td>
<td>-REVO</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
</tbody>
</table>

2.2 Document Submissions for Planning or OCII – Subsequent Submissions

<table>
<thead>
<tr>
<th>First Component</th>
<th>Second Component</th>
<th>Third Component</th>
<th>Fourth Component</th>
<th>Fifth Component (as Applicable)</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>002, 003…</td>
<td>-SITE FORMS</td>
<td>-REV1, REV2…</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>102, 103…</td>
<td>-SITE DWGS</td>
<td>-REV1, REV2…</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>202, 203…</td>
<td>-SITE SPECS</td>
<td>-REV1, REV2…</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>302, 303…</td>
<td>-SITE CALCS</td>
<td>-REV1, REV2…</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>402, 403…</td>
<td>-SITE REPORTS</td>
<td>-REV1, REV2…</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>502, 503…</td>
<td>-SITE LETTERS</td>
<td>-REV1, REV2…</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
</tbody>
</table>

2.3 Document Submissions for Building – Initial Submissions

<table>
<thead>
<tr>
<th>First Component</th>
<th>Second Component</th>
<th>Third Component</th>
<th>Fourth Component</th>
<th>Fifth Component (as Applicable)</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>-BLDG FORMS</td>
<td>- REVO (as applicable)</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
</tbody>
</table>
### 2.4 Document Submissions for Building – Subsequent Submissions

<table>
<thead>
<tr>
<th>First Component</th>
<th>Second Component</th>
<th>Third Component</th>
<th>Fourth Component</th>
<th>Fifth Component (as Applicable)</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>002, 003...</td>
<td>-BLDG FORMS</td>
<td>-REV0</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>102, 103...</td>
<td>-BLDG DWGS</td>
<td>-REV0</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>202, 203...</td>
<td>-BLDG SPECS</td>
<td>-REV0</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>302, 303...</td>
<td>-BLDG CALCS</td>
<td>-REV0</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>402, 403...</td>
<td>-BLDG REPORTS</td>
<td>-REV0</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>502, 503...</td>
<td>-BLDG LETTERS</td>
<td>-REV0</td>
<td>APPLICATION NUMBER</td>
<td>_ADD[X]</td>
<td>.pdf</td>
</tr>
</tbody>
</table>

### 2.5 Document Submissions for Building – Addendum Document Submissions

<table>
<thead>
<tr>
<th>First Component</th>
<th>Second Component</th>
<th>Third Component</th>
<th>Fourth Component</th>
<th>Fifth Component (as Applicable)</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>001, 002...</td>
<td>-BLDG FORMS</td>
<td>-REV[X] (as applicable)</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X] Grading</td>
<td>.pdf</td>
</tr>
<tr>
<td>101, 102...</td>
<td>-BLDG DWGS</td>
<td>-REV[X]</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X] Foundation</td>
<td>.pdf</td>
</tr>
<tr>
<td>201, 202...</td>
<td>-BLDG SPECS</td>
<td>-REV[X]</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X] Superstructure</td>
<td>.pdf</td>
</tr>
<tr>
<td>301, 302...</td>
<td>-BLDG CALCS</td>
<td>-REV[X]</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X] Architecture</td>
<td>.pdf</td>
</tr>
<tr>
<td>401, 402...</td>
<td>-BLDG REPORTS</td>
<td>-REV[X]</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X] MEP</td>
<td>.pdf</td>
</tr>
<tr>
<td>501, 502...</td>
<td>-BLDG LETTERS</td>
<td>-REV[X]</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_ADD[X] Final</td>
<td>.pdf</td>
</tr>
</tbody>
</table>
Appendix 2: Document Naming Conventions for Applicant Submissions to Port of SF

Note: All documents submitted to Port must follow the below naming guidelines. Please note the Port uses different naming conventions for permit submittals than the San Francisco Department of Building Inspection. The descriptions and tables below identify the most common submissions.

1.0 Port of SF Document Naming Components and Naming Structure

1.1 File Name Examples
- B-2022_0001_BLDG DWGS-REV0.pdf
- B-2022-0001_BLDG ADD_1 Architecture_DWGS-REV1.pdf
- B-2022-0001_BLDG ADD_2 MEP_CALCS-REV1.pdf

1.2 File Name Component Summary

1.2.1 Port Submission File Names will always contain five parts:
- **Permit Type.** Building Permit or Encroachment
- **Year.** The year drawings associated with the permit were first accepted for review by the Port Permit Desk.
- **Unique 4-Digit Number.** Provided by the Port Permit Desk. Note unlike DBI (which nests addenda submittals under a project’s permit number) the Port issues a new unique 4-digit permit number for each addendum issued.
- **Document Type.** The Port accepts three document types: Drawings, Calculations, and Reports
- **A Revision Number.** Include a “REV0” in all files of the Initial Submission. Subsequent Revisions will be numbered “REV1”, “REV2”, etc.

1.3 File Name Component Order

1.3.1 File name components will be in the following order:
- `[Permit Type]_[Year]_[4-Digit Number]_[Document type]-[Revision Number]

1.3.2 If no Application number exists, substitute the street address of the project:
- `[Permit Type]_[Year]_[Street Address]_[Document Type]-[Revision Number]

1.4 Permit Type Naming Conventions

1.4.1 The Port accepts 2 Permit types:
- Building Permits (B)
- Encroachment Permit (E)

1.5 Document Type Naming Conventions

1.5.1 The Port accepts six document types.
- Forms (FORMS)
- Drawings (DWGS)
- Specifications (SPECS)
- Calculations (CALCS)
• Reports (REPORTS)

1.5.2 Permit Type Naming Conventions

Note: For each document type, the Applicant must specify if they are for or Building Permits or Encroachment Permits in the file name. (Note: the Port treats site permits as Building Permits)

1.5.3 Building Permit Name Examples:
• Drawings: BLDG DWGS
• Calculations: BLDG CALCS
• Reports: BLDG REPORTS

1.5.4 Encroachment Permit Name Examples:
• Drawings: ENCR DWGS
• Calculations: ENCR CALCS
• Reports: ENCR REPORTS

1.6 Addenda Naming Conventions

1.6.1 Addenda must contain "BLDG ADD_[X]" as well as the addenda type included. CCSF and the Port accept the following types of addenda:
• Grading
• Foundation
• Superstructure
• Architecture
• Mechanical, electrical and plumbing (MEP)
• Final

1.7 Revision Number Naming Conventions

1.7.1 Include a revision number as "-REV[X]" with the X being the revision number (REV1, REV2, etc.). Submittal first drafts include a "REV0" number.

2.0 Document Naming Table for Port of SF Submissions

2.1 Documents for the Port of SF

<table>
<thead>
<tr>
<th>First Component</th>
<th>Second Component</th>
<th>Third Component</th>
<th>Fourth Component</th>
<th>Fifth Component*</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>-BLDG FORMS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>-BLDG DWGS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>-BLDG SPECS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>-BLDG CALCS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>-BLDG REPORTS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>-BLDG LETTERS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
</tbody>
</table>
### 2.2 Addendum Documents for Port of SF

<table>
<thead>
<tr>
<th>First Component</th>
<th>Second Component</th>
<th>Third Component</th>
<th>Fourth Component</th>
<th>Fifth Component</th>
<th>Sixth Component*</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_BLDG ADD [X] Grading</td>
<td>_BLDG DWGS, CALCS, REPORTS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_BLDG ADD [X] Foundation</td>
<td>_BLDG DWGS, CALCS, REPORTS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_BLDG ADD [X] Superstructure</td>
<td>_BLDG DWGS, CALCS, REPORTS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_BLDG ADD [X] Architecture</td>
<td>_BLDG DWGS, CALCS, REPORTS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_BLDG ADD [X] MEP</td>
<td>_BLDG DWGS, CALCS, REPORTS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
<tr>
<td>Permit Type</td>
<td>Year</td>
<td>APPLICATION NUMBER, if applicable. If not applicable, use ADDRESS or PROPERTY NAME</td>
<td>_BLDG ADD [X] Final</td>
<td>_BLDG DWGS, CALCS, REPORTS</td>
<td>-REV[X]</td>
<td>.pdf</td>
</tr>
</tbody>
</table>
Appendix 3: Bluebeam Versions and Use for Applicants

Applicants who choose to use Bluebeam in order to partake in the Electronic Plan Review process should understand that some components of that process use a paid (licensed) version of Bluebeam, and some components use a free (unlicensed) version of Bluebeam.

Breaking down the EPR workflow described in these Procedures into the three main components: formatting PDFs, submitting/resubmitting files, and responding to Reviewers’ comments, it is important to note which components use free or paid software:

- Formatting PDF Documents for submittal / resubmittal - Bluebeam Revu Standard or Bluebeam Revu eXtreme (see table below)
- Submitting / resubmitting documents via sf.gov website – Bluebeam not required.
- Submitting / resubmitting documents via Studio Session or Studio Project – Any licensed (paid) version of Bluebeam Revu
- Joining the Bluebeam Session and responding to Reviewers’ comments – any licensed (paid) or unlicensed (free) version of Bluebeam Revu

Applicants or Applicant Subcontractors wishing to review and respond to in-Session CCSF Review comments can do so using a free (unlicensed) version of Bluebeam. The free (unlicensed) version of Bluebeam is simply an installed trial version where the trial has expired. Note that this functionality will only be available when working on Session documents while inside a Bluebeam Session.

1.0 Identification of Paid (Licensed) or Free (Unlicensed) Versions

Note: The table below defines the need for a paid/free version of Bluebeam Revu. Items defined below are specific to Procedure Items from this EPR Applicant Procedure.

<table>
<thead>
<tr>
<th>Procedure Item</th>
<th>Free or Paid / Bluebeam Version</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0 Account Setup for Bluebeam Studio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1 Create a New Studio Account</td>
<td>Free / Any Version</td>
<td></td>
</tr>
<tr>
<td>2.2 Set Required User Naming Conventions for Studio Account</td>
<td>Free / Any Version</td>
<td></td>
</tr>
<tr>
<td>3.0 Prepare Drawing Documents for Submittals</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1 Resources for Best Practice PDF Creation</td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>3.2 Document Naming Conventions for Document Submittals</td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>3.3 Sheet Count and Drawing Index</td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>3.4 Blank Areas on Cover Page and in Title Block for Stamps</td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>3.5 Document Size and Volumes</td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>3.6 Document Scale</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>3.7 Scanned Document Prep</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>3.8 Convert JPG Image files Back to PDF</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>3.9 Run Optical Character Recognition on Scanned PDF files</td>
<td>Paid / eXtreme only</td>
<td>Step 3.9 is optional</td>
</tr>
<tr>
<td>3.10 Create Page Labels in Thumbnails</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>3.11 Create Bookmarks</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>3.12 Nesting Bookmarks</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>3.13 Set Scale on Floor Plans</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>3.14 Remove Layers</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>3.15 Create Drawing Call-Out Hyperlinks</td>
<td>Paid / eXtreme only</td>
<td>Step 3.15 is optional</td>
</tr>
<tr>
<td>3.16 Flatten Document</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>4.0 Prepare Additional Files for Submittals</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.1 Specifications Prep</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>4.2 Other Supporting Document Prep</td>
<td>Paid / Any Version</td>
<td></td>
</tr>
<tr>
<td>5.0 Submit Documents to CCSF for Electronic Plan Review</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.1</td>
<td>Submitting files via the CCSF City website (sf.gov)</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>-----</td>
<td>---------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>5.2</td>
<td>Submitting files directly into a Bluebeam Studio Session</td>
<td>Paid / Any Version</td>
</tr>
<tr>
<td>5.3</td>
<td>Submitting files directly into a Bluebeam Studio Project</td>
<td>Paid / Any Version</td>
</tr>
<tr>
<td>6.0</td>
<td>Intake of Applicant Submittal Files</td>
<td></td>
</tr>
<tr>
<td>7.0</td>
<td>Initial Electronic Plan Review Process</td>
<td></td>
</tr>
<tr>
<td>8.0</td>
<td>Incorporate CCSF Review Comments</td>
<td></td>
</tr>
<tr>
<td>8.1</td>
<td>Joining the Bluebeam Studio Session via Email Link</td>
<td>Free / Any Version</td>
</tr>
<tr>
<td>8.2</td>
<td>Joining a Bluebeam Studio Session via Session ID</td>
<td>Free / Any Version</td>
</tr>
<tr>
<td>8.3</td>
<td>Navigating Documents &amp; Review Comments</td>
<td>Free / Any Version</td>
</tr>
<tr>
<td>8.4</td>
<td>Filtering Comments</td>
<td>Free / Any Version</td>
</tr>
<tr>
<td>8.5</td>
<td>Applicant Response – Incorporating Comments</td>
<td>Free / Any Version</td>
</tr>
<tr>
<td>8.6</td>
<td>Add an additional “Reply” to comments</td>
<td>Free / Any Version</td>
</tr>
<tr>
<td>8.7</td>
<td>Applicant Response – Not Incorporating Comments</td>
<td>Free / Any Version</td>
</tr>
<tr>
<td>9.0</td>
<td>Subsequent Submittals</td>
<td></td>
</tr>
<tr>
<td>9.1</td>
<td>Submit Subsequent files via the CCSF City Website (sf.gov)</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>9.2</td>
<td>Submit Subsequent Files Directly to a Session or Project</td>
<td>Paid / Any Version</td>
</tr>
<tr>
<td>9.3</td>
<td>Intake of Applicant Subsequent Submittal files</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>9.4</td>
<td>Subsequent Electronic Plan Review Process</td>
<td>Free / Any Version</td>
</tr>
<tr>
<td>10.0</td>
<td>Stamp-Out and Approval</td>
<td></td>
</tr>
</tbody>
</table>